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ACE Certification Checklist
The checklist below will help guide you through the process of obtaining ACE certification.

Review this bulletin to become familiar with the topic areas and objectives of the exam.
Identify the topic areas and objectives you need to study.
Determine which study materials you need to improve your skills.

For a list of recommended study materials, visit:
http://www.adobe.com/misc/training.html

Study for the exam.

Contact Pearson VUE to register for an exam: http://www.pearsonvue.com/adobe

When registering for the exam, refer to the exam number located at the top of this bulletin.
Take the exam.

Your score is electronically reported to Adobe. Please allow 2-4 weeks from the date you
pass the exam to receive your ACE Welcome Kit.
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Exam Structure

The following lists the topic areas and percentage of questions delivered in each topic area:

Topic Area % of # of
Exam Questions
Laying out a document 18% 11
Working with text 19% 12
Working with tables 6% 4
Managing graphics 10% 6
Understanding color and transparency 10% 6
Creating and working with long documents 11% 7
Importing, exporting, and working with cross-media 11% 7
Managing prepress and printing 15% 9

Number of Questions and Passing Score
e 62 questions
e 69% minimum required to pass

Test Content: Topic Areas and Objectives
Following is a detailed outline of the information covered on the exam.

1. Laying out a document

e Given a scenario, work with master pages.

e Use Quick Apply to assign styles and choose menu commands.
e Use Layers to organize the structure of a document.

« Explain the process of using Data Merge to build a template and import data into a final

InDesign or PDF document.
» Create and use a snippet file.

* Maodify and transform objects by using the transformation tools and the Control panel.

e Use the Info panel to find hidden or non-obvious information about your document.

« Create, apply, and modify an object style.
* Create, edit, and manipulate text on a path.
e Describe the use of Smart Guides.

e Arrange multiple document windows.

2. Working with text

* Insert special characters by using the Type menu, Glyph panel, or context menu.

* Given an option, edit text.
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Adjust the look of text inside a text frame by using Text Frame Options.
Manipulate text flow by using text threading, smart text reflow, resizing, and text wrap.
Given a scenario, create and apply styles in an automated fashion.

Create a basic GREP expression for find/change or GREP styles without having to write
code.

Create a user dictionary and populate it with custom words.

Import an RTF or Word file and map style names to styles in the current document.
Assign and format automatic bullets or numbering to paragraphs.

Given a scenario, set up a document or frame-based baseline grid.

Make a dynamically changing running head.

Given a feature, avoid widows, orphans, and other typographic problems.
Working with tables

Modify tables.

Edit and format a table.

Create, apply, import, modify, and organize cell and table styles.

Update the information in a table when the original data has changed.
Managing graphics

Given a scenario, determine the best settings for choosing and placing an image.
Locate the XMP metadata for an image placed in InDesign

Determine the current resolution for a placed image.

Hide or show layers in placed PSD, Al, INDD, and PDF files, and discuss how image
transparency is handled.

Manage placed files by using the Links panel.
Understanding color and transparency
Explain the use of named swatches versus unnamed colors.

Given a scenario, create, modify, and apply gradients to objects or text using the
appropriate panels and tools.

Describe how and why to create mixed inks.

Assign transparency effects to stroke, fill, and image/text individually.
Given a scenario, choose the best course of action to manage color.
Creating and working with long documents

Insert and format footnotes in a document.

Create a book in a book panel and paginate the documents.
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» Create a table of contents across one or more documents.

e Synchronize master pages, styles, and swatches in a book

» Define and insert text variables.

e Create and apply text conditions and condition sets.

« Create and apply cross-references, edit cross-reference format.

7. Importing, exporting, and working with cross-media

«  Select the appropriate options for exporting to XFL for use in Flash CS4.

« Create interactivity for an InDesign document that will be exported as a PDF document.
«  Create functional hyperlinks in exported PDF documents or SWF files.

«  Apply and customize page transitions for exported PDF documents or SWF files.

» Select the appropriate options for exporting to XHTML for use on a Web site.

« Define and assign XML tags, and export an XML file.

*  Map styles to tags and XML tags to styles using the Tags panel and the Structure view.
8. Managing prepress and printing

e Troubleshoot common printing issues by using Live Preflight.

e Troubleshoot common printing issues by using the Separations Preview panel.

e Troubleshoot common transparency printing issues by using the Flattener Preview panel.
« Given a scenario, choose the appropriate Print dialog box options.

« Given a scenario, choose the appropriate PDF Preset or PDF Export settings.

Practice Exam

Try out these practice questions to get a feel for the types of questions on the ACE exam. Please
note that your performance here does not indicate how you will do on the actual exam. To fully
prepare for the exam, closely review the topic areas and objectives in this Exam Bulletin.

1.4 Explain the process of using Data Merge to build a template and import data into a
final InDesign or PDF document.

You want to use Data Merge to create labels based on data from a CSV file. You want the
labels to appear in a grid on the page, 3 across and 8 down. You set up the first placeholder
label on a document page. However, when you open the Create Merged Document dialog box,
the Records per Document Page pop-up menu is disabled and you cannot set it to Multiple
Records.

What needs to change in order for you to create the grid of labels?
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You must use a facing pages document instead of a single-sided document.
You need to delete all but one of your document pages.

You need to put the text and graphic frames on the master page instead of the document
page.

You must create enough blank pages to contain the final merged document before per-
forming the data merge.

Correct answer: B

1.5 Create and use a snippet file.

You want to create a snippet file containing a linked graphic and text to use in other docu-
ments. Which statement is true?

A.

C.
D.

The graphic and text must be grouped before creating the snippet.

The snippet can only be placed into a new document with the same page dimensions as the
original document.

Text must be converted to outlines before creating the snippet.

The snippet file remembers the layer names for each object.

Correct answer: D

2.2 Given an option, edit text

You want to edit a story in a simple word-processing window that allows you to see the entire
story, including overset text. What should you do?

A.

use the Type tool to click inside the story, press Command-A (Mac OS) or Ctrl-A (Win-
dows) to select the whole story and then choose View > Hide Frame Edges

choose Edit > Edit in Story Editor, and then File > Open to navigate to the InDesign docu-
ment containing the story you want to edit

select the text frame with the Selection tool or Direct Selection tool, or click inside it with
the Type tool, and choose Edit > Edit in Story Editor

ensure that Adobe InCopy and the InCopy plug-ins are installed. Then triple-click inside
the frame with the Type tool

Correct answer: C
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3.2 Edit and format a table

You want to insert a footnote number in a table cell and place the footnote at the bottom of the
table. What should you do?

A. You place the cursor inside the cell you want the footnote and choose Type > Insert Foot-
note.

B. You place the cursor inside the cell you want the footnote and click the New Note button
in the Notes panel.

C. You use the Type tool to manually type a footnote number in the cell. You then add an
extra row at the bottom of the table, and insert the footnote text in it.

D. You place the text cursor inside the cell you want the footnote and choose Type > Insert
Special Character.

Correct answer: C

4.1 Given a scenario, determine the best settings for choosing and placing an image

You want to replace an image from a selected frame. The new image is larger than the original
image. You want the new image to be imported at the same scaling percentage as the original.
What should you do?

A. hold down Shift as you click the Relink button in the Links panel

B. hold down Option/Alt as you click the Update button in the Links panel

C. before replacing the image, deselect Preserve Image Dimensions When Relinking in the
File Handling pane of the Preferences dialog box

D. before replacing the image, select Preserve Image Dimensions When Relinking in the File
Handling pane of the Preferences dialog box

Correct answer: C

5.5 Given a scenario, choose the best course of action to manage color

You choose Edit > Color Settings while a document is open. Which color profiles are affected
when you change the values in the RGB and CMYK pop-up menus and click OK?

A. the color profiles that the current document assigns to images that have no embedded pro-
files (does not apply to other documents)

B. the color profiles that future documents assign to images that have no profiles embedded
(does not apply to current document)
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C. the color profiles that are assigned to all images and swatches you place or create in this
document after changing this setting

D. the color profiles that are assigned to RGB and CMYK swatches (does not affect placed
images)

Correct answer: B

6.4 Synchronize master pages, styles, and swatches in a book

You have three documents in a Book panel, named A, B, and C. Document A is the style
source file. You deselect all the documents in the panel and choose Synchronize Book from
the Book panel menu. Which result is true?

A. If document B has styles and swatches with different names than document A, they are
deleted.
B. The styles and swatches from documents B and C are loaded into document A.

C. If document B has styles and swatches with the same names but different definitions, they
will be redefined to match document A.

D. The result depends on the settings in each document's Numbering & Section Options dia-
log box.

Correct answer: C
7.1 Select the appropriate options for exporting to XFL for use in Flash CS4
Which InDesign feature can be maintained when you export an XFL file?

A. hyperlinks

B. page transitions
C. interactive buttons
D. editable text

Correct answer: D

8.1 Troubleshoot common printing issues by using Live Preflight

You want InDesign to alert you if your art is not bleeding off the page properly according to
your print provider's specifications. What should you do?
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A. You enter the correct Bleed size by choosing File > Document Setup.

w

You create an Adobe PDF Preset that has Use Document Bleed Settings selected.

C. Ina custom preflight profile, you select the Bleed and Slug Setup checkbox. You then
select the Bleed Size Must Be checkbox and enter the desired distance from the page edge.

D. In acustom preflight profile, you select the Bleed and Slug Setup checkbox, the Bleed
Size Must Be checkbox, and the Bleed/Trim Hazard checkbox. You then enter the desired
distances from the page edge.

Correct answer: D

8.3 Troubleshoot common transparency printing issues by using the Flattener Preview
panel.

You are viewing a multi-page document with transparency effects on every page. You open the
Flattener Preview panel, set the Highlight pop-up menu to All Affected Objects, and select the
Auto Refresh Highlight checkbox. You notice that transparent objects are not appearing high-
lighted on the first page. What could cause this?

A. Custom settings were applied to the page by selecting Spread Flattening from the Pages
flyout menu.

B. You selected a transparency flattener preset with the Raster/Vector Balance set at less than
75 percent.

C. Ignore Spread Overrides was selected in the Advanced tab of the Export Adobe PDF dia-
log box.

D. While page one was selected in the Pages panel, the Isolate Blending checkbox was
selected in the Effects panel.

Correct answer: A
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